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Introduction

Welcome to Sage ACT! Premium 2013 (access via web). Sage ACT!, the #1 Contact and Customer
Management choice of small businesses and sales teams, is designed to help you build the long-
lasting, profitable relationships your business thrives on.

Sage ACT! Premium (access via web) lets users access Sage ACT! Premium databases using a
supported browser. It is important that you review the full system requirements and supported
compatibility list at www.act.com/systreq.

Whether you are installing Sage ACT! Premium (access via web) for the first time or upgrading from an
earlier ACT!, ACT! for Web, Sage ACT! Premium (Web), or Sage ACT! Premium (web client) version,
this guide provides the information to:

e Plan and organize a Sage ACT! Premium (access via web) installation.
e Set up useraccess to Sage ACT! Premium (access via web).

e Install the Sage ACT! Scratchpad and set up integration with supported applications, such as
Microsoft® Outlook® or Google®.

e Troubleshoot the software.

IMPORTANT INFORMATION TO KNOW BEFORE YOU START

To determine the guide you need to start with, see the following:

I do not have any version of ACT! or Sage ACT], installed. I am a "New User." See the
Installing Sage ACT! 2013 for New Users guide along with this Web Administrator's guide to complete
your Sage ACT! Premium (access via web) installation. The Installing Sage ACT! 2013 for New Users
guide provides the steps to install, register, and activate Sage ACT! Premium (access via web). The
guide is included with the software and is available as a PDF on the installation panel under Product
Documentation.

I have an ACT! 2005 (7.x) through Sage ACT! 2012 (14.x) version installed. I may or
may not have a web version installed. See the Upgrading to Sage ACT! 2013 from ACT! versions
2005 (7.x) -2012 (14.x) guide along with this Web Administrator's guide to complete your Sage ACT!
Premium (access via web) installation. The Upgrading to Sage ACT! 2013 from ACT! versions 2005
(7.x)-2012 (14.x) guide provides the steps to install, register, and activate Sage ACT! Premium
(access via web) and upgrade your database. The guide is available as a PDF on the installation panel
under Product Documentation.

Upgrade Web User. When you see this icon throughout the guide, it indicates information that is
applicable to you.

I have an ACT! 3.x, 4.x, 5.x (2000), or 6.x (2004) installed. See the Upgrading to Sage ACT!
2013 from ACT! versions 3.x, 4.x, 5.x (2000), or 6.x (2004) guide along with this Web Administrator's
guide to complete your Sage ACT! Premium (access via web) installation. The Upgrading to Sage ACT!
2013 from ACT! versions 3.x, 4.x, 5.x (2000), or 6.x (2004 ) guide provides the steps to install,
register, and activate Sage ACT! Premium (access via web) and convert your database. The guide is
available as a PDF on the installation panel under Product Documentation.

Adobe® Reader® is required to access and view product documentation from the installation panel.
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Getting Started

In this section, you will learn about:
e Planning your installation, including common configuration suggestions.
e Understanding the ASP.NET Process and user impersonation account.
e Using Application pools.
e Installing Sage ACT! Premium (access via web) in single- or multiple-server configurations.

e Using the Web Site Administration tool and default virtual directory to set up and configure Sage
ACT! Premium (access via web).

e Using Secure Sockets Layer (SSL) with Sage ACT! Premium (access via web).
e Working with user preferences.

This section also includes installation and configuration checklists. You can print the page for the
checklist that you need.

Planning Your Installation

Sage ACT! Premium 2013 (access via web) requires Microsoft Internet Information Services (IIS) and
ASP.NET to function. See Microsoft documentation to help you plan your installation and prepare your
web server. You need to understand your operating system, IIS, ASP.NET, and user permissions
required to run a web page.
To determine whether you will install the Sage ACT! Premium (access via web) software and the
database together on one server or separate servers, consider the following:

e The number of users who require access to the database and the number of users who will

access the Sage ACT! Premium (access via web) site. For recommendations, review the system
requirements at www.act.com/systreq.

o How frequently this software and other services will access the server.

e Whether users need access from both inside and outside your network. If access is required from
outside the network, two possible server/database configurations are:

o Install Sage ACT! Premium (access via web) using a single-server configuration, where the
web server also hosts Sage ACT! Premium (access via web) databases.

o Install using a multiple-server configuration, where you have a web server hosting the Sage
ACT! Premium (access via web) software and Internet Information Services (I1S), and a
database server hosting the Sage ACT! Premium (access via web) database (including the
Microsoft® SQL Server® software to manage the database). You then connect to the
database from the web server. (Recommended for more than 30 users.)

Both server configurations are discussed later in this guide.
Configuration Suggestions

The following are suggestions for configuring Sage ACT! Premium (access via web). Actual results may
vary depending on the size of your database and network configuration.

e Host the application server on a dedicated instance of Microsoft SQL Server.

e The database server should have 3 GB memory for every 50 users in the database. The hard
drive speed is most important on this computer. With faster hard drive speeds, users may
experience better performance. This computer's performance can benefit if you use 64-bit SQL
Server and have quad core processors.

e The application server should have 3 GB memory for every 50 users in the database. CPU and
memory are most important on this computer. With more memory, users may experience
better performance.
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o If possible, distribute mail merge and reporting tasks. On the client machine, mail merge can be
the most performance consuming task. On the database server, reporting can be intensive. It is
recommended that you run reports during a time when users are not logged on, such as at
night.

e If possible, put the Sync server on an outfacing machine and not on the same machine as the
database. Internet sync is recommended because it is already running IIS, but you can have
both Internet and Network sync set up to act as a safeguard or as a way to balance load. See
"About Database Synchronization" in the Help for more information about Internet and Network
Sync.

Understanding the ASP.NET Process and Impersonation User Accounts

An ASP.NET process account is required for ASP.NET to function. It is usually managed by Windows®,
and it requires the permission: Impersonate a client after authentication. The default account name
varies, depending on the operating system on your web server. The Web Site Administration tool lets
you test the ASP.NET process account to verify it exists and is properly configured. For more
information about configuring and troubleshooting the ASP.NET process account and service, see the
Sage ACT! Knowledgebase at www.act.com/support.

The Sage ACT! Premium (access via web) software uses ASP.NET to access the database and other
files. You create a Windows user account, and then use the Web Site Administration tool to configure
the software to use that account. An impersonation account is required to let a user who does not
have access to the network impersonate a user who does. This gives an ASP.NET application access to
Windows resources using the account you provide.

2013 (access via web). The impersonation user assigned in your previous Sage ACT! Premium (web

@ Upgrade Web User. You may not need to create a new impersonation user for Sage ACT! Premium
client) or ACT! Premium for Web version should be retained and usable after upgrading the software.

Using Application Pools

An Internet Information Services (IIS) application pool is used to isolate ASP.NET web applications and
help increase the stability and security of the applications. An application pool can include one or more
applications. You can configure the level of isolation between them. For example, you can create an
application pool for each application running on the same computer. If errors occur in one pool, they
will not affect applications running in other pools. Sage ACT! uses the default application pool named
DefaultAppPool. You can create a custom application pool for Sage ACT! Premium (access via web). If
you do create a custom application pool for Sage ACT! Premium (access via web), be sure to select the
Use Default Settings option. Otherwise, Sage ACT! Premium (access via web) users may receive errors
or be disconnected when accessing the web site.

Each application pool has one or more worker processes. A worker process is a process that runs the
web site. The worker processes are unique to the application pool and are not shared across application
pools. A worker process is responsible for handling requests sent to a web server for a specific
application pool.

Application Pool Recycling

Application pools can be periodically recycled to avoid unstable states that can lead to application
crashes, hangs, or memory leaks. By default, Microsoft sets application pool worker processes to
recycle every 29 hoursor 1,740 minutes.

Note: We recommend that you reset the default recycling interval for the application pool assigned
to Sage ACT! Premium (access via web) to recycle every 24 hours or 1,440 minutes. To do this, see
"Changing the Default Recycling Interval for an Application Pool" on page 21.
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If desired, you can perform an on-demand recycle. For Sage ACT! Premium (access via web), an on-
demand recycle is recommended after web users have installed the Sage ACT! Scratchpad and/or
configured integration with Google or Outlook. For steps on how to perform an on-demand recycle, see
"Recycling an Application Pool" on page 21.

For more information about application pools, see Microsoft documentation.

Installing in Single- or Multiple-Server Configurations

The following explains the differences and recommendations for installing Sage ACT! Premium (access
via web) in single- or multiple-server configurations.

Single-Server Configurations

You can install Sage ACT! Premium (access via web) using a single-server configuration, where the
web server also hosts the database.

Note: If you are also using Sage ACT! Premium (Desktop) version, you cannot install Sage ACT!
Premium (access via web) on the same server.

To deploy Sage ACT! Premium (access via web) in a single-server configuration, the impersonation
user account you create should:

e Be added to the local Administrators group.

e Have permission to access the Sage ACT! Premium (access via web) database and database
supplemental files.

Multiple-Server Configurations

For scalability and enhanced performance, you can configure Sage ACT! Premium (access via web) to
use multiple servers. The most common types of server configurations used are:

e One web server and one database server.
e Multiple web servers (with or without a database server).

e Oneor more web servers running multiple application pools. For more information about
managing application pools in IIS, see Microsoft Help.

For a multiple-server configuration, the impersonation user account you create should:
e Be astandard domain user.

e Be added to the local Administrators group on all servers that are part of the Sage ACT! Premium
(access via web) deployment.

e Have permission to access the database supplemental files for your Sage ACT! Premium (access
via web) database on the database server.

e Have permission to access all Sage ACT! Premium (access via web) files on the web server.

You may have two or more instances of Sage ACT! Premium (access via web) hosted on one web
server. In such cases, you can use virtual directories or application pools to distinguish and secure
each Sage ACT! Premium (access via web) web site.

Multiple Virtual Directories

You can create multiple virtual directories within your default web site. For example, you may have
two directories — one called Sales and one called Service. Sage ACT! Premium (access via web) users
access the sites using a URL followed by the virtual directory name (for example,
http://domain.com/sales). You point each virtual directory to the Sage ACT! Premium (access via web)
installation directory. The installation directory differs for your operating system.

TIP: For more information about configuring Sage ACT! Premium (access via web) using multiple
virtual directories, see the Knowledgebase Article #14868.

Sage ACT! Premium 2013 Web Administrator's Guide
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Recommendations When Installing in Multiple-Server Configurations
The following are recommendations when installing Sage ACT! Premium (access via web) in a
multiple-server configuration:
e Ifyou have more than 50 users on a single web server, use multiple application pools.
e You may have two or more instances of Sage ACT! Premium (access via web) hosted on one web
server. In such cases, you can use virtual directories or application pools to distinguish and

secure each Sage ACT! Premium (access via web) site. You should also isolate any supplemental
data for each web site.

e Disable all unnecessary Windows services on the web server, such as Network News Transfer
Protocol (NNTP) or File Transfer Protocol (FTP).

o Allow access through the firewall only to the web server. Do not allow access to the database
server. See your firewall documentation for instructions.

e When using more than one web server, you can set Sage ACT! Premium (access via web) user
preferences to be shared across multiple web servers. For more information, see "About User
Preferences" on the facing page.

Using the Web Site Administration Tool

The Web Site Administration tool, located on the Tools menu in the Sage ACT! Premium server
application, contains several tabs for configuring Sage ACT! Premium (access via web).
Web Server tab. Use to test that your ASP.NET process account exists and the service is started.
User Account tab. Use to specify and test the Windows user account for ASP.NET impersonation.
Add/Remove Database tab. Use to assign or remove a Sage ACT! Premium database to or from
your virtual directory.
Options tab. Use to change the session timeout limit for Sage ACT! Premium (access via web) users.
By default, the timeout limit is set to 20 minutes.
The Web Site Administration tool also does the following:

e Encrypts the user name and password.

e Sets up ASP.NET impersonation using the specified user.

¢ Verifies that the impersonation user can access the required files and folders.

o Verifies that the ASP.NET process account has access to the registry key required to run Sage

ACT! Premium (access via web).

About the Default Virtual Directory
During installation, Sage ACT! Premium (access via web) creates a default virtual directory called
"apfw". Users will need this default virtual directory name and the URL of your web server to access

the product. For example, if the name of your web server URL is "salesweb", users will access the
product with the address of "http://salesweb/apfw".

On the Add/Remove Database tab of the Web Site Administration tool, you assign Sage ACT! Premium
databases to this virtual directory. Then, users can open their web browser and type in the web
address to open the product and log on to an assigned Sage ACT! Premium database. You can test
whether your configuration can access the files and folders required for Sage ACT! Premium (access
via web). You should do this test whenever you make changes to the configuration, such as adding or
removing databases or changing passwords.

You can find additional information about Sage ACT! Premium (access via web) and the Web
Administration tool in Knowledgebase articles at www.act.com/support.
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Using Secure Sockets Layer (SSL) with Sage ACT! Premium (access via
web)

Secure Sockets Layer (SSL) uses an encryption key to encrypt data between a web server and client
so that others cannot access it. You may want to configure SSL in your version of IIS if you plan to
integrate Sage ACT! Premium (access via web) with another application, such as Outlook. With SSL,
communications between Sage ACT! Premium (access via web) and Outlook are secure. In IIS, you
specify which portions of your Default Web Site to secure with SSL. You can secure the entire Default
Web Site or only a specific virtual directory or page.

Consider the following scenarios:

e Ifyour web server only hosts Sage ACT! Premium (access via web), you can use SSL to secure
the entire Default Web Site. The Sage ACT! Premium (access via web) logon page and all child
pages will be secured with SSL. You must precede all URLs with "https" rather than "http."

e If other web pages are hosted on your web server, you can use SSL to secure only the virtual
directory where the Sage ACT! Premium (access via web) software logon page is set up. The
logon page and all pages within Sage ACT! Premium (access via web) will be secured with SSL.
You must precede all URLs with "https" rather than "http."

Best practices if you plan to use SSL with Sage ACT! Premium (access via web):
e Add an exception for port 443 (the default port for SSL).

e Ifyou plan to integrate with another application, such as Outlook, open the Web.config located
at \\<install folder>\ApfwoutlookSrvc\ and comment out the UnSecured section and
uncomment the Secured one. See "Editing the Outlook Service Web.config File to Use a Secured
Service" on page 17.

e Have caching of encrypted pages/files turned On. Users accessing the web site will need to check
their browser settings to allow caching. See "Browser Requirements for Sage ACT! Premium
(access via web) Users" on page 15.

To configure SSL on IIS, see Microsoft documentation.

About User Preferences

Sage ACT! Premium (access via web) stores user preferences in a WebPreferences.xml file on the web
server that hosts the product. Preferences let users customize name and salutation settings, change
background colors and fonts, create custom spelling check dictionaries, and set other options for how
they use Sage ACT! Premium (access via web). In some cases, you may want to distribute web
requests across multiple web servers. If you do this, each web server will have a unique set of stored
user preferences. If a user changes a preference when logged onto server 1, that change will not be
reflected on server 2.

To make sure users have the same settings, you can set up a shared location to store user
preferences. Then, when a user logs on, their user preferences will be the same no matter what server
responds to their logon request.
Depending on your operating system, user preferences are stored at:

e \\Windows\System32\inetsrv\ACT\ACT forWeb\Preferences

e \\Users\[Impersonation User]\AppData\Roaming\ACT\ACTfor Web\Preferences.

preferences changed after the ACT! for Web 2006 release, some preferences may be lost after
upgrading. To restore these user preferences, copy all files and folders from the old preference location

@ ACT! for Web 2005 or 2006 Upgrade Users Only. Because the storage location for user
to the new preference location and reset IIS. See Help for steps on how to reset IIS.

The steps to set up a shared location for user preferences is explained in "Setting Up Shared
Preferences Across Web Servers" on page 14.
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Installation and Configuration Checklists

The following installation and configuration checklists outline the tasks to install and configure Sage

ACT! Premium 2013 (access via web). Follow the checklist for your user type.

New User Installation and Configuration Checklist
The guides you will need to complete your installation and configuration are:

e Installing Sage ACT! 2013 for New Users for Tasks 2 - 4.
e Sage ACT! Premium 2013 Web Administrator's Guide for Tasks 1, 6-10.

Task Guide Page #

1 Determine whether you will use a single- | Sage ACT! Premium 2013 Web 3
server or multiple-server configuration. | Administrator's Guide

2 Prepare to install. Important: Be sure to | Installing Sage ACT! 2013 for New 2.3
complete both sets of steps. Users

3 Install, register, and activate Sage ACT! | Installing Sage ACT! 2013 for New 4-7
Premium (access via web). Users

4 Create a shared database and add users | Installing Sage ACT! 2013 for New 8-9
toit. Users

5 Install Sage ACT! Sync Services. "Installing Sync Services" in Help

6 Create a Windows user account for Sage ACT! Premium 2013 Web 11
ASP.NET impersonation. Administrator's Guide
Use the Web Site Admin tool to configure ) .

7 the web site. Provide users with access igg;ﬁg;;gfg’gﬁdgm 3 Web 12
information.
Set up shared preferences across web Sage ACT! Premium 2013 Web

8 b . . 14
servers. Administrator's Guide

9 Have users configure supported Sage ACT! Premium 2013 Web 15
browsers. Administrator's Guide
Have users integrate Sage ACT!
Premium (access via web) with other ) .

10 applications. Important: Be sure to jzgifig;aﬁgiggjﬂdgow e 17
recycle the application pool after users
have installed integration components.
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Upgrade from ACT! 2005 (7.x) - 2011 (13.x) Installation and

Configuration Checklist

The guides you will need to complete your installation and configuration are:

e Upgrading to Sage ACT! 2013 from ACT! versions 2005 (7.x) - 2012 (14.x) for Tasks 2-6
e Sage ACT! Premium 2013 Web Administrator's Guide for Tasks 1, 7-12

Task Guide Page #

If no previous Web installation,

1 determine whether you will use a Sage ACT! Premium 2013 Web 3
single-server or multiple-server Administrator's Guide
configuration

2 Understand what happens during the | Upgrading to Sage ACT! 2013 from ACT! i
upgrade process. versions 2005 (7.x) -2012 (14.x)

3 Prepare to install. Important: Be Upgrading to Sage ACT! 2013 from ACT! 1
sure to complete both sets of steps versions 2005 (7.x) - 2012 (14.x)

4 Install, register, and activate Sage Upgrading to Sage ACT! 2013 from ACT! 3
ACT! Premium (access via web). versions 2005 (7.x) - 2012 (14.x)
Upgrade the database. Important: |, .0 to Sage ACT! 2013 from ACT!

5 Ensure the database remained versions 2005 (7.x) - 2012 (14.x) 4
shared. If not, share it. ’ ’
Install Sage ACT! Sync Services.
Note: If you used previous versions of

6 ACT! Sync Services, you must Upgrading to Sage ACT! 2013 from ACT! 9
uninstall them and install the versions 2005 (7.x) -2012 (14.x)
versions that work with Sage ACT!
Premium 2013.
If no previous Web installation, create , .

7 a Windows user account for ASP.NET jggﬁ?g;;gf?g’ﬂdgm‘? Web 11
impersonation.
Use the Web Site Admin tool to

8 verify/configure the web site and Sage ACT! Premium 2013 Web 12
provide users with access Administrator's Guide
information.
ACT! for Web 2005 or 2006 .

]

9 | users only: Copy files and folders for igﬁfgg;gﬁggﬂdgm3 web 5
user preferences.
Set up shared preferences across web | Sage ACT! Premium 2013 Web

10 C ) , 14
servers. Administrator's Guide
Have users verify/configure supported | Sage ACT! Premium 2013 Web

11 S ] . 15
browsers. Administrator's Guide
Have users integrate Sage ACT!
Premium (access via web) with other

12 applications. Important: Be sureto | Sage ACT! Premium 2013 Web 17
recycle the application pool after users | Administrator's Guide
have installed integration
components.
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Installation and Configuration Checklists

Upgrade from ACT! 3.x, 4.x, 5.x (2000), or 6.x (2004) Installation and
Configuration Checklist
The guides you will need to complete your installation and configuration are:

e Upgrading to Sage ACT! 2013 from ACT! versions 3.x, 4.x, 5.x (2000), or 6.x (2004) for Tasks
2-7

e Sage ACT! Premium 2013 Web Administrator's Guide for Tasks 1, 8-12

Task Guide Page#
Determine whether you will use a ’ ;
1 single-server or multiple-server Sage ACT! Pre’m/unj 2013 Web 3
) . Administrator's Guide
configuration
Upgrading to Sage ACT! 2013 from ACT!
2 Prepare the database for conversion. versions 3.x, 4.x, 5.x (2000), or 6.x 1
(2004)
. . Upgrading to Sage ACT! 2013 from ACT!
3 Prepare to install. Important: Be sure versions 3.x, 4.x, 5.x (2000), or 6.x 5
to complete both sets of steps
(2004)
i ] ]
4 Install, register, and activate Sage ACT! Upgr_ad/ng to ‘S’ageSACTéOZgol3 frog’; ACT! 3
Premium (access via web). versions 3., 4.x, 5.x ( ), or6.x
(2004)
Convert the database. Important: Upgrading to Sage ACT! 2013 from ACT!
5 Ensure you select the "Share versions 3.x, 4.x, 5.x (2000), or 6.x 5
Target Database" option. (2004)
Upgrading to Sage ACT! 2013 from ACT!
6 Convert supplemental files. versions 3.x, 4.x, 5.x (2000), or 6.x 6
(2004)
Upgrading to Sage ACT! 2013 from ACT!
7 Install Sage ACT! Sync Services. versions 3.x, 4.x, 5.x (2000), or 6.x 9
(2004)
8 Create a Windows user account for Sage ACT! Premium 2013 Web 11
ASP.NET impersonation. Administrator's Guide
Use the Web Site Admin tool to .
/
9 configure the web site. Provide users i3$ﬁf§;a€£fggﬂd§013 web 12
with access information.
10 Set up shared preferences across web Sage ACT! Premium 2013 Web 14
servers. Administrator's Guide
11 Have users configure supported Sage ACT! Premium 2013 Web 15
browsers. Administrator's Guide
Have users integrate Sage ACT!
Premium (access via web) with other , .
12 | applications. Important: Be sure to i‘?ﬁ,‘;ﬁgg;{;ﬁ?gﬂd§013 Web 17
recycle the application pool after users
have installed integration components.

Sage ACT! Premium 2013 Web Administrator's Guide
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Setting Up Sage ACT! Premium (access via web)

Administrators must perform several steps to set up and configure Sage ACT! Premium (access via
web). Users must configure a supported browser and get the web address URL from the Administrator.

In this section, Administrators will learn how to:
e Create a Windows user account for ASP.NET impersonation.

for your existing ACT! web site. This impersonation user should not be affected during upgrade or

@ Upgrade Web User. You will have a Windows user account for ASP.NET impersonation already set up
previous version uninstall. You may want to test the Windows user account after upgrading.

e Use the Web Site Administration tool to set up access to Sage ACT! Premium (access via web).
e Provide access to the software from inside and outside a common network.
e Set up shared user preferences across web servers (optional).

In addition, users will learn how to configure supported browsers to allow access to Sage ACT!
Premium 2013 (access via web).

Creating a Windows User Account for ASP.NET Impersonation

The following section explains how an Administrator creates a Windows user account for ASP.NET
impersonation. In a multiple-server configuration, the impersonation user account should:

e Be astandard domain user.

e Be added to the local Administrators group on all servers that are part of the Sage ACT! Premium
(access via web) deployment.

Note: Depending on your operating system, the following steps may differ.

Create a Windows user account for ASP.NET impersonation

1. To create a new user account, open Local Users and Groups. Specific steps to do this
depend on your operating system. For example, on Windows Server® 2008, you can use the
Server Manager>Configuration menu to access Local Users and Groups.

Expand Local Users and Groups, and then click the Users folder.

3. Use your operating system's menus to create a new user. For example, on Windows Server
2008, you click the Action menu, then click New User.

a. Type a User name (this would be the user’s logon name, for example,
"sageactimpersonator") and a Full name (this can be the same as the User name).

Type a password and confirm it.
Clear the User must change password at next logon check box.
Click Create. Then, click Close.

Write down the User name and password because you will need it later when you use the
Web Site Administration tool to test the impersonation user.

Next, add the new user to a group that has access permissions. For the impersonation
account, add it to the Administrators group.

© a0 -
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4. Right-click on the name of the user you created. Click Properties. (The step might differ for
your operating system.)
a. Inthe Properties dialog box, click the Member Of tab. Click Add.
b. Inthe Select Groups dialog box, in the Enter the object names to select box, type the
word Administrators.
c. Click Check Names to resolve the Administrator’s group. (The group name will appear
underlined.)
d. Click OK.
5. Close all dialog boxes.

Using the Web Site Administration Tool

The next section describes how an Administrator uses the Web Site Administration tool to perform
three configuration tasks to set up Sage ACT! Premium (access via web). You do not need to exit the
tool as you move through the tabs to complete the setup.

ACT! Premium 2013 (access via web), you will need to assign the upgraded database to the web site so

@ Upgrade Web User. If you removed the database from your ACT! web site before upgrading to Sage
that users can access it.

For the first task, an Administrator must validate that an ASP.NET process account exists and is
correctly configured on the web server.

Note: To access this feature, you must be running Windows as an administrator or disable User
Access Control (UAC). See your operating system's help for how to do these tasks first.

Test the ASP.NET process account
1. OntheTools menu, click Web Site Administration.
2. Onthe Web Server tab, click Test. A message appears.
o Ifthetest is successful, click OK.

e Ifthe testis not successful, an error message appears. This may indicate that an ASP.NET
process account does not exist or is incorrectly configured. Click OK to close the message.
For help, see "Troubleshooting Sage ACT! Premium (access via web)" on page 23.

Correct any errors and repeat step 2 until the test is successful. The test must be successful
before you can access the User Account tab.

The second task is to specify and test the Windows user account for ASP.NET impersonation.

set up for your Web version should be available after installation. You will not need to click Edit or make
changes. Proceed to the test step. If the test is not successful, you may have to create a new Windows

@ Upgrade Web User. Your existing Windows user account for use in ASP.NET impersonation that you
user account for ASP.NET impersonation.

Specify and test the Windows user account for ASP.NET impersonation
1. Click the User Account tab.
2. Click Edit.

a. From the Windows Domain list, select the domain for your impersonation user. (Your
domain may already appear in the list.) If you receive an error message that the Web Site
Administration tool is unable to access the Windows domain, the Windows User Name does
not exist, or you entered an invalid password, correct the errors, and try again.

b. Type the user name and password you set up for the Windows user account. Click OK.
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3. Click Test. A message appears.
e Ifthe test is successful, click OK.

e Ifthe testis not successful, or the ASP.NET process account does not have the required
access to the registry key, an error message appears. This may indicate that the
impersonation user does not have the required access to files and folders. Click OK to close

the message. For help, see "Troubleshooting Sage ACT! Premium (access via web)" on page

23.

If necessary, correct errors and repeat the steps until the test is successful. The test must be
successful before you can access the Add/Remove Database tab.

The final task is to assign a Sage ACT! Premium (access via web) database to a virtual directory. By
default, during installation, a virtual directory called "apfw" was created.

Assign a database to a virtual directory

1. Onthe Add/Remove Database tab, in the Web site list, the name Default Web Site
appears. This means the application is looking in the Default Web Site directory of I1S. If you
created a custom web site, select it from the list.

A list of available virtual directories for the selected web site appears in the Virtual directories
box.

2. Inthe Virtual directories box, by default, APFW appears for Default Web Site. If you have a
custom web site and virtual directory, select the virtual directory from the list.

3. Toadd a Sage ACT! Premium database to the virtual directory, click Add.

a. Browse tothe Sage ACT! Premium database to associate with your selected virtual
directory. Click OK.

b. When prompted to log on, enter your user name and password. Click OK.
A Test is Successful message should appear. If it does not appear, click TestDB.
e Ifthe testis successful, click OK.

e Ifthe testis not successful, an error message appears. This may indicate that the
impersonation user account does not have the required access. Click OK to close the
message. For help, see "Troubleshooting Sage ACT! Premium (access via web)" on
page 23.

Changing the Session Timeout Limit

If desired, you can change the default session timeout limit which controls how long users can be idle
and remain logged on to Sage ACT! Premium (access via web). The default setting is 20 minutes. For
security purposes, we recommend a maximum limit of two hours.

Change the session timeout limit
1. On the Options tab, from the Session timeout list, select a timeout limit. Click Apply.
2. Ifamessage appears, click Yes to continue.
3. Click Close.

Microsoft IIS services are automatically restarted so the new session timeout limit can take
effect.

Sage ACT! Premium 2013 Web Administrator's Guide
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How Users Access Sage ACT! Premium (access via web)

For users to have access to Sage ACT! Premium (access via web), an Administrator must add them to
the database and assign them a user role. The number of users is dependent on the purchased
licenses and how many users have "Active" status. For more information on adding users, see
"Adding, Editing, or Deleting Users" in Help.

Then, provide the web address for Sage ACT! Premium (access via web) to users. This address consists
of the virtual directory name appended to the web site URL.

Access from Inside a Common Network

If the web server and users are on a common network, users can access the software using the
network computer name of the web server. In the two examples below, that name is “salesweb” and
“teamwebserver.”

Examples are:

e http://salesweb/apfw, where “salesweb” is your site URL, and “apfw” is the virtual directory
name

e http://teamwebserver/apfw

Access from Outside a Common Network

Users cannot use the network machine name to access the software from outside the common
network. Instead, provide an external IP address or a URL for a registered domain name. In the
examples below, that information is "12.129.78.35" or "www.yourcompanyname.com."

Examples are:

e http://www.xxx.com:8080/apfw, where "www.xxx.com" is your site domain name and "8080"
is the port number used to access the site

e https://www.xxx.com:443/apfw, where "www.xxx.com" is your site domain name and "443" is
the secured port used to access the site

e http://12.129.78.35/act, where "12.129.78.35" is the external IP Address
e http://www.yourcompanyname.com/apfw

Setting up external Internet access to Sage ACT! Premium (access via web) may require additional
configuration. Refer to Microsoft IIS Help or contact your Internet Service Provider for assistance.

Setting Up Shared User Preferences Across Web Servers

The following section explains how to set up a shared location to store user preferences for Sage ACT!
Premium (access via web) users. You would want to do this if you distribute web requests across
multiple web servers.

Note: If the shared preference storage location is offline when a user logs on to Sage ACT! Premium
(access via web), the preferences that are stored locally on the user’s system are accessed for the
duration of the session.

Set up shared user preferences
1. Identify the web servers that host Sage ACT! Premium (access via web).
2. Verify that the impersonation user is the same for each web server in the cluster.
3. Select a computer that all of the web servers can access (for example, Preference_Server).

a. On this computer, create and name a folder to store the shared preferences. (For example,
SharedPrefs.)

b. Share the folder you created. Grant Change and Read permission to your impersonation
user account.
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4. On awebserverin the cluster, locate and open the web.config file for the APFW virtual
directory. By default, this file is located at \\Program Files\ACT\ACT for Web\APFW.

Note: You can open the web.config file in Notepad. If you have the Folder Option set to Hide
Extensions for known file types, this file appears as "web".

a. Inthe web.configfile, locate the Preferences Shared Network Folder entry shown below.

<!--
Shared network folder to store preferences (cluster setup)leave this value
empty if single web server
-—>
<add key="PreferencesSharedNetworkFolder" value="" />
b. Edit the entry by inserting the UNC path to your shared folder between the quotation
marks following value=. For example, if your server name is Preference_Server, and your
folder name is SharedPrefs, then you would insert \\Preference_Server \SharedPrefs, as
shown below.
. <!-- Shared network folder to store preferences (cluster setup) Leave

this value empty if single web server --> <add
key="PreferencesSharedNetworkFolder" value="\\Preference Server\SharedPrefs"

/> ...
c. Save and close the web.config file.

5. Repeat Steps 4a-c on the remaining web servers in the cluster. If all web servers in the cluster
use the same configuration, you can copy the modified web.config file to the other web
servers.

Tip: You can use Windows Distributed File Services (DFS) to replicate one web.config file
across all servers. See Windows documentation for help.

Configuring Supported Browsers (Web Users)

To open Sage ACT! Premium (access via web), users must have a supported web browser. Currently,
the supported browsers are Microsoft Internet Explorer® and Mozilla® Firefox®*. To see supported
versions, go to www.act.com/systreq. For Sage ACT! Premium (access via web) to function properly,
each browser has required settings. In addition, depending on your browser choice, some Sage ACT!
Premium (access via web) features are not available.

The following sections describe the required settings and feature limitations for each browser.

*Mozilla and Firefox are registered trademarks of the Mozilla Foundation.

Required Browser Settings
To access and use Sage ACT! Premium (access via web) with a supported browser, the following
settings are required.
Internet Explorer Settings
General tab:
e Under Browsing History, click Settings. Select Check for newer versions of stored pages
Automatically.
Security tab:
e Under Trusted Sites, click Sites and clear Require server verification (https:) for all
sites on this zone.
e Tothelist of trusted sites, add Sage ACT! Premium 2013 (access via web) and about:
internet.(1)

(1) Required for Web Help to open on Windows® Server® 2003 or Windows Server 2008. The Help file is an
uncompiled Web Help system which includes the Mark of the Web (MOTW) setting in each Help topic (.htm). The
MOTW setting has the "about:internet" text embedded into each Help topic.
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Security tab:
e Use the Default Level for security (Low).

e Click Custom level and enable (or set to prompt) Initialize and script ActiveX controls not
marked safe for scripting(2) and Drag and drop or copy and paste files (allows access to
Windows clipboard).

Privacy tab:

e Click Advanced. Enable Override automatic cookie handling, Accept First-Party
Cookies, and Accept Third-Party Cookies.

e Clear Turn on Popup Blocker.
Advanced tab:

e Ifyour Sage ACT! Premium (access via web) web site is configured to use Secure Sockets Layer
(SSL), under Security, clear Do not save encrypted pages/files to disk. It is best practice
to have caching of encrypted pages/files turned on when using Sage ACT! Premium (access via
web) over SSL.

Firefox Browser Settings
Privacy panel:
e Under History, from the Firefox will list, select Use custom settings for history.
e Select Accept cookies from sites and Accept third-party cookies.
Content panel:
o Ifselected, clear Block pop-up windows.
e Click Exceptions and add the Sage ACT! Premium (access via web) site domain to the list.
e Select Enable JavaScript.

If your Sage ACT! Premium (access via web) web site is using Secure Sockets Layer (SSL), ensure the
caching for SSL is set to "True".

1. Open Firefox and in the address bar of the browser, type about:config.
2. Scroll down to browser.cache.disk_cache_ssl, and double-click it to change the setting:
e “True” indicates SSL content will be cached.
e “False” indicates SSL content will not be cached.
Browser Limitations
Each supported browser has limitations when used with Sage ACT! Premium (access via web). This
means there are certain features or functions you cannot perform in Sage ACT! Premium (access via
web).
Internet Explorer
e View Source function is not available.
e Right-click shortcut menu is not available
Firefox
e The ACT! Word Processor is not available.
e Mail Merge is not available.

(2) Configuring ActiveX® security is required to allow install of word processing controls to create templates and
documents. Users need to install two ActiveX controls. If your client-side web security policies prohibit users
from installing ActiveX controls, add both the domain associated with your Sage ACT! Premium (access via web)
server installation and Microsoft.com to the Trusted Sites zone in Internet Explorer. Configure Internet Explorer
to prompt users when installing ActiveX controls only for sites in the Trusted Sites zone. Doing this bypasses the
ActiveX security constraints only for the necessary controls.
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Integrating Sage ACT! Premium (access via web) With Other
Applications

You can integrate Sage ACT! Premium (access via web) with:
e The Sage ACT! Scratchpad.
e Microsoft Word, Outlook, Word, and Excel®.
e Google.

The Sage ACT! Scratchpad is a separate application that lets users enter and manage tasks, to-do
items, and more. They can enter personal or work-related items in the Sage ACT! Scratchpad and
create notes, histories, and activities in Sage ACT! Premium (access via web) from items entered.
Integration with the Sage ACT! Scratchpad requires that users must install Sage ACT! Scratchpad to
place an icon on their desktop. Users open Sage ACT! Scratchpad and set their Send to Sage ACT!
preferences to specify a database to receive the note, history, or activity.

Integration with Word, Outlook, and Google requires configuration by an Administrator and users.
Some of the Administrator tasks must be done before users can set up integration with other
applications. Integration with Excel does not require any configuration; however, all Microsoft
applications must be installed on the computer prior to installing Sage ACT! Premium 2013 (access via
web).

This section explains the Outlook and Google requirements as well as the tasks for an Administrator
and users to set up integration with other applications.

Tasks an Administrator can do before users set up integration are:

e Edit the Outlook Service web.config file to use a secured service if you have configured IIS to
Secure Sockets Layer (SSL).

o Edit the web.config file to allow users access to Outlook from outside the network.
Tasks a user can do are:

e Install the Sage ACT! Scratchpad and set Send to Sage ACT! preferences.

e Install the Microsoft Word component.

e Install the integration component to use with Outlook integration (email, contacts and calendar
sync) or Google integration(contacts and calendar sync and Gmail record history).

After users have installed the integration component and set up their integration preferences with
either Outlook or Google, an Administrator can recycle the Sage ACT! Premium (access via web)
application pool so that the application refreshes and integration tools and menus are available.

Editing the Outlook Service Web.config File to Use a Secured Service

The following steps explain how to comment out the unsecured section and uncomment the secured
section of the web.config file so that you can securely use Outlook integration. You must have already
configured IIS to use Secure Sockets Layer (SSL).

Edit the web.config file to use a secured service
1. Navigate to the web.config file located under <install folder>\ApfwoutlookSrvc.
2. Select the web.config file and open it in Notepad.
3. Tocomment out the unsecured section, locate the following text:
<!-- Following is UnSecured Configuration. -->
<services>
4. Comment out <services> so that it looks like this:

<!--<services>
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5. Touncomment the secured section, locate the following text:

<!-- Following is SSL Secured Configuration. Please comment Unsecured
Configuration above and un-comment SSL secured configuration below in order
to enable Security over SSL -—>

<!--<services>

6. Uncomment <!--<services> so that it looks like this:

<services>

7. Save thefile.

Editing the Web.config File for Outlook Integration

The following steps explain how to edit the web.config file located under the APFW directory to allow
users access to Outlook from outside the network.

Note: You must also configure your firewall to permit access from outside the network. For more
information, see your firewall documentation.

Edit the web.config file

1. Navigate to the APFW folder on the server where Sage ACT! Premium (access via web) is
installed. By default, the file is located at \\Program Files\ACT\Act for Web\APFW.

2. Select the web.config file. Open it in Notepad.

3. Locate the Act.Web.OutlookWebServiceAddress parameter, which looks similar to the
following:

<add key="Act.Web.OutlookWebServiceAddress" value="http:/
/www . xxx.com:8080/apfw" />

4. Replace the text following "value=" with the IP address or domain name for the Sage ACT!
Premium (access via web) site.

5. On the File menu, click Save.
After editing the web.config file, let users know they can install the integration component.

Installing the Sage ACT! Scratchpad

The following steps explain how a user installs the Sage ACT! Scratchpad to use it with Sage ACT!
Premium (access via web). It only needs to be installed once.

Install Sage ACT! Scratchpad
1. OntheTools menu, click Install Sage ACT! Scratchpad.
2. At the message prompt, click Yes.
3. On the dialog box that appears, click Save to save the compressed (.zip) file to a location on
your computer. For example, save it to the Desktop.
4. When the process is complete, extract the files. Use a program like WinZip® to extract the
files.
5. Double-click the setup.exe file to install the Sage ACT! Scratchpad. Select or accept all actions
required for your operating system to install it.
After installation, a shortcut named Sage ACT! Scratchpad (Web) is placed on your desktop.
Double-click the shortcut to open Sage ACT! Scratchpad.
Next Step

e Open Sage ACT! Scratchpad and set your Send to Sage ACT! preferences. For more
information, see "Setting My Send to Sage ACT! Preferences" in Help.
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Installing a Mail Merge Component to Use Microsoft Word

The following steps explain how users can install a mail merge component to use Microsoft Word for
creating letters and other documents, and performing mail merges from Sage ACT! Premium (access
via web). If users plan to use the ACT! Word Processor instead of Word, skip this installation.

existing Mail Merge component, and then download and install the current version of the component.

@ Upgrade Web User. To record history and edit Word documents, users must first uninstall the
Use Add/Remove Programs to uninstall the existing version.

Install the Mail Merge component to use Microsoft Word
1. Close Word.
Open Sage ACT! Premium (access via web).
On the Tools menu, click Preferences.
Click the Word Processor hyperlink.
In the Word Processor Preferences dialog box, select Microsoft Word from the list.
Click the Download button.

Note: If the integration component cannot be downloaded, check to see if the Sage ACT!
Premium (access via web) site URL is added to the Trusted Sites zone.

oA WwWN

7. When prompted to run or save the file, click Run. Follow all remaining prompts to install the
integration component. Click Finish.

8. Click OK.

Setting Up Integration with Outlook or Google

Users can integrate Sage ACT! Premium (access via web) with Microsoft Outlook or Google. Integration
allows Sage ACT! Premium (access via web) to add to and use features of Outlook or Google, such as:

e Outlook email including Sage ACT! address books (contacts) and Quick Attach for emails.
e Outlook calendar and/or contacts synchronization.

e Google integration including calendar and/or contact synchronization and recording history of
Gmail messages to contacts.

Users can install the integration component once to use it with either Outlook or Google.

Note: Users should synchronize their calendar and contacts with either Outlook or Google, but not
both. Synchronizing with both applications may cause duplicate data.

The following sections describe the integration requirements and how users can install the integration
component.

Outlook Integration Requirements
To set up the integration connection between Sage ACT! and Outlook, users need:

e A compatible version of Microsoft Outlook. For supported versions, see system requirements at:
www .act.com/systreq.

e Outlook installed and working correctly.
e An Outlook profile set up.
Google Integration Requirements
To set up the integration connection between Sage ACT! and Google, users need:
e Internet access to a Google account.
e A Google account username and password.
e Authorization for Sage ACT! to access the Google account.
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e To have logged on to their Google calendar at least once before setting up calendar integration
with Sage ACT!.

¢ (Recommended) Google added to their web browser's Trusted Sites list.

e .NET Framework 4.0. If .NET Framework is not detected, it will be installed with the Google
Integration components.

Installing the Integration Component
Users only need to install the integration component once to use it with either Outlook or Google.

Install the integration component

1. Close the application to integrate with. For example, if users plan to integrate with Outlook,
close it.

Open Sage ACT! Premium (access via web).
3. Dependingon the task users are attempting, have them do one of the following:

e If users are setting up Outlook email: On the Tools menu, click Preferences. Click the E-
mail hyperlink. Then, in the E-mail Integration box, click the Download button.

e Ifusers are setting up Outlook contacts/calendar sync: On the Tools menu, click
Preferences. Click the Outlook Synchronization hyperlink.

e Ifusers are setting up Google integration: On the Tools menu, point to Integrate with
Google, and then click Google Integration Preferences.

Note: If the integration component cannot be downloaded, check to see if the Sage ACT!
Premium (access via web) site URL is added to the Trusted Sites zone.

If a message appears, read it and click Install.

5. When prompted to run or save the file, click Run. Follow all remaining prompts to install the
integration component. Click Finish.

Important: After the first user downloads and installs the integration component, the
Administrator must now reset IIS on the web server to complete Google or Outlook
integration setup. Any subsequent downloads and installs of the integration component by
other web users do not require an I1IS reset.

6. Ifusers are setting up Outlook contacts/calendar sync and have installed the integration
component using the Outlook Synchronization hyperlink, users must then install the
APFWOutlookDetect add-on.

a. Click the browser information bar.

If the browser information bar does not display, go to the Tools menu and click
Preferences. Click No when prompted to install additional software.

b. Click Run Add-on.
c. When the security warning appears, click Run.
Next Steps

e Open Sage ACT! Premium (access via web) and set up email and calendar/contacts
synchronization with Outlook or integration with Google. See Help for steps on how to do this.

e An Administrator must recycle the application pool so that integration tools and menus are
available in Sage ACT! Premium (access via web). See the next section.
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Recycling an Application Pool

An Administrator may have to immediately recycle an application pool instead of waiting for the next
configured recycle. Rather than abruptly stopping it, which can cause service interruptions, you can
use on-demand recycling. You would do an on-demand recycle after users have installed the Sage
ACT! Scratchpad and/or installed integration components.

The following steps explain how to use the IIS Manager to recycle an application pool on demand.

Recycle an application pool using the IIS Manager

1. Toopen IIS Manager using the Run dialog box, do one of the following for your operating
system:

e On the Start menu, click All Programs, click Accessories, and then click Run.
e On the Start menu, click Run.

In the Open dialog box, type inetmgr. Click OK.

Expand the local computer and click Application Pools.

3. Select the Sage ACT! Premium (access via web) application pool. By default, it is
DefaultAppPool. If you have created a custom application pool for Sage ACT! Premium
(access via web), select it.

4. On the Actions menu, or on the right pane, under Application Pool Tasks, click Recycle. If
a confirmation message appears, click Yes

5. Close IIS Manager.
If desired, you can change the default recycling interval. The next section describes why and how.
Changing the Default Recycling Interval for an Application Pool

Microsoft sets the default recycling interval at 1,740 minutes (29 hours) to restart an application pool.
We recommend you change the interval to 1,440 minutes (24 hours). A shorter recycling interval
may help with application crashes and recovery of system resources.

Change the default recycling interval for an application pool

1. Toopen IIS Manager using the Run dialog box, do one of the following for your operating
system:

e On the Start menu, click All Programs, click Accessories, and then click Run.
e On the Start menu, click Run.
In the Open dialog box, type inetmgr. Click OK.

2. Expand the local computer and click Application Pools.

3. Doone of the following:

e Right-click the Sage ACT! Premium (access via web) application pool, and select
Properties. By default, Sage ACT! Premium (access via web) uses DefaultAppPool. On the
Recycling tab, for Recycle worker processes (in minutes), change 1740 to 1440.
Click OK.

e On theright pane, under Edit Application Pool, click Recycling. Under Fixed
Intervals, for Regular time intervals, change 1740 to 1440. Click Next. Click Finish.

4. Close IIS Manager.
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Troubleshooting Sage ACT! Premium (access via web)

This section helps you identify solutions to:
e Web Site Administration tool errors.
e General configuration issues or errors.

Troubleshooting Web Site Administration Tool Errors

This section describes how to troubleshoot error messages received while configuring your software.
When troubleshooting, you may also refer to the Web Site Administration tool log file
(AFWAdminLog.log) and the validation log file (validate.txt). These files may provide information about
user permissions and errors displayed in the tool, such as ASP.NET and HTTP errors. The Web Site
Administration tool must be closed to create an updated log file. Log files are located in: <ACT!
installation path>\ACT\ACT for Web\Logs.

Additional information for troubleshooting the Web Site Administration tool is provided in the Sage
ACT! Knowledgebase.

Tip: To bypass errors in the Web Site Administration tool, hold down the SHIFT or CTRL key and click
another tab. For example, you may want to view information on another tab before completing the
configuration.

Web Server and User Account Tabs

Microsoft SharePoint® software detected. Additional configuration
may be required to enable Sage ACT! Premium (access via web) to
run.

Cause:

e SharePoint was detected on the web server. Some installations of
SharePoint modify the default web site and ASP.NET service
configuration.

Solution:

e You many need to perform additional steps for the Sage ACT! Premium
(access via web) web site to function. See the Sage ACT!
Knowledgebase.

The ASP.NET process account does not exist or is not configured
properly.

Causes:
e The ASP.NET service is not available.

e Non-default IIS settings, such as an assigned IP address or host
headers, are configured.

e Read permissions are not set.

Solutions:
o Verify that the ASP.NET service is available.
o Verify the configuration of the ASP.NET process account.

e Manually configure users and permissions as described in
Knowledgebase Article #14867.
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User Account Tab

Unable to retrieve Windows domain information at this time. This
information is required to edit the Windows User Account. Please
check with your network administrator and try again later.

Cause:
e The Windows domain information is unavailable.

Solution:

e See your network administrator to verify that you have access to the
domain.

The ASP.NET process does not have permission to access or run
Sage ACT! Premium (access via web).

Cause:

e The ASP.NET process account does not have the permissions on the
web server to run Sage ACT! Premium (access via web).

Solution:

e This account requires Read permission for the registry key that
contains the encrypted impersonation user credentials. Verify the
correct account for your web server configuration.

The impersonation user account does not have access to files and
folders required to run Sage ACT! Premium (access via web) on
your web server.

Cause:

e The Access to program files and folders or registry permissions required
to run Sage ACT! Premium (access via web) has not been granted to
the impersonation user account.

Solution:

e Verify that the user is at least a domain user and part of the local
Administrators group, and then set the appropriate permissions to the
Sage ACT! Premium (access via web) files and folders on the server.

The Windows user account information you have entered is
invalid. Please check the user name and password and try again.

Causes:

e The Windows user name or password you entered does not exist in the
selected Windows domain.

e The option to force users to change their password at logon has been
selected.

Solutions:

e Verify that you entered the correct user name for the selected domain.
If you did, you may need to create a user. For more information, see
"Creating a Windows Impersonation User Account" on page 11.

e For the impersonation user account, clear the User must change
password at next logon check box.
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Add/Remove Databases Tab

The impersonation user account does not have access to the
database you selected.

Cause:

e Theimpersonation user specified on the User Account tab does not
have permission to access the program files and folders or registry
permissions required to run Sage ACT! Premium (access via web).

Solution:

¢ Verify that the user has the appropriate permission to access all Sage
ACT! Premium (access via web) files and database supplemental files
on the server.

The web page fails to load after selecting a web site and virtual
directory.

Causes
e Various.

Solutions:

e Ifyou are testing a web site that was working previously, execute the
tests on the Web Server and User Account tabs to determine the cause
of the issue. Your web server configuration may have changed, for
example:

e The password for the impersonation user account was changed or
has expired.

o New software or services, such as SharePoint or Active Directory,
were installed on the web server.

e The application pool where the Sage ACT! Premium (access via web)
virtual directory runs was modified.

e Ifyou just created the impersonation user account, you may not have
cleared the option to force the user to change the password at the next
logon. Clear the User must change password at next logon check box.

e Ifyou just successfully executed the tests on the Web Server and User
Accounts tabs, restart IIS on the web server. See Help for how to do
this.
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Troubleshooting General Errors and Issues
This section describes how to troubleshoot general issues and errors with regard to installation,
configuration, security, and so on.
General Errors and Issues

Problem:

e To continue with the installation, you receive a prompt to let
Sage ACT! Premium (access via web) switch your 64-bit IIS
and ASP.NET applications to 32-bit compatibility mode. You
do not want to automatically switch the mode. The web page
fails to load after selecting a web site and virtual directory.

Reason:

e Automatically switching the mode will cause other web applications on
your computer to run in 32-bit mode. If those applications require 64-
bit mode, they will cease running; if not, they should continue running,
however, they will have less RAM to access.

Solution:

e Set upone web serverto run the web application that requires 64-bit
IIS and ASP.NET. Set up a second web server to run Sage ACT!
Premium (access via web), Internet Synchronization and any other
32-bit IIS and ASP.NET applications.

Problem:

e Sage ACT! Premium (access via web) Help is not opening
when you click Help topics or the Help menu.

Reason:

e Sage ACT! Premium (access via web) Help is a Web Help help system
containing the Mark of the Web (MOTW) setting in each Help topic
(.htm). On some server operating systems using Internet Explorer, a
blank page appears when Help is accessed.

Solution:

e Addthe about:internet site to your Trusted Sites zone or your local
intranet zone. The about:internet setting refers to the MOTW security
setting in each help topic.

Problem:
e You receive the message: "Web site is not running".

Reason:
e IIS may not be running.

Solution:
o Verify that IIS and the default web site are running.

Sage ACT! Premium 2013 (access via web)



Troubleshooting Sage ACT! Premium (access via web)

Problem:

e Errors appear on a remote browser, but not while using the
browser on the server.

Reasons:
e Pop-up blockers are enabled.
e The web site is not a trusted site on client computers.
e Your Internet security software does not allow access.

Solution:
e Disable pop-up blockers in Internet Explorer or Firefox.
e Addthe web site to the list of trusted sites on all client computers.
e Shut down the Internet security software to allow access.

Problem:

e You receive the message: "400 - Bad Request" or "404 - File
not found".

Reason:
e The Web Site Administration tool tests the site using "localhost."

Solution:

e Ifthe Sage ACT! Premium (access via web) site is configured to use an
IP address, it will not use "localhost".

Problem:
e You receive the message: "500 - Internal server error".

Reason:

o Windows Server 2003 contains a section of IIS that deals with web
service extensions.

Solution:
e Make sure that ASP.NET version 2.0.50727 is set to Allowed.

Problem:
e You can access the web site internally, but not externally.

Reason:
e Your router may not be configured correctly.

Solution:

e Ensure your router is forwarded to port 80. For more information, see
your router documentation.
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Problem:

e You receive a message saying "... If you continue to see this
message, please recycle your IIS application pool, restart
IIS, or contact your Administrator".

Reason:

e You have just installed the Sage ACT! Scratchpad or the integration
component to use supported applications with Sage ACT! Premium
(access via web) and this message appears.

Solution:

e An Administrator needs to recycle the application pool as it is less
disruptive than resetting IIS. See "Recycling an Application Pool" on
page 21.

Problem:
e You receive the message: "403 - Forbidden".

Reason:
e You do not have permission to access a file.

Solutions:
e Ensure the impersonation user is a Windows Administrator.

e Ifyou created a custom virtual directory, ensure the Read and Run
Scripts (such as ASP) are enabled. See Knowledgebase Article #14868.

Problem:

e You are accessing Sage ACT! Premium (access via web)
using a secured connection (https://) and settings are not
being retained. For example, you are scheduling an activity
and as you move through the Schedule Activity tabs, settings
are changing back to the defaults.

Reason:

e Your browser may not have the correct setting to allow caching of
pages/files when using Secure Sockets Layer (SSL). It is a best practice
to have caching of encrypted pages/files turned on when using Sage
ACT! Premium (access via web) over SSL.

Solution:

e ForInternet Explorer: Click Tools>Internet Options. Click the
Advanced tab. Under Security, clear Do not save encrypted pages/files
to disk.

e For Firefox: Open Firefox and in the address bar, type about:config.
Scroll to the browser.cache.disk_cache_ ssl setting. It should be set to
True. If it is False, double-click it to change the setting.

e See Knowledgebase Article #28245.
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